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1. Introduction 

The Beauty Contest document type is probably one of the most crucial document types we have 
when it is used for pitches.  Traditionally it has been very rich in design and sometimes it has been 

quite difficult to make the document perform properly due to numerous section breaks, complex 

numbering schemas and the limitations of Office 2003.  With the upgrade to Office 2010 the Beauty 
Contest (BCON) template has been reconstructed from scratch with a new design, taking advantage 

of some of the new features available in Word 2010. 

During work on the template no reference was made to the previous version.  Therefore the new 

BCON template has very little in common with the previous version by design.  The two versions 

should be considered as completely incompatible with each other.  Instead, the new BCON should 

lend itself to being more accessible to our colleagues at Ashurst Australia, making the exchange of 

BCON documents easier. 

2. Overview of changes 

As mentioned, the new BCON template has very little in common with its predecessor and it would 
be easier to list the similarities.  However, these are some of the changes you will notice: 

 The first thing you will notice is that there is no longer a dialog box.  The title and subtitle of the 
document can be typed directly onto the front page. 

 A newly created BCON has a cover page and a back page already attached.  The graphic has 
been designed so that pre-printed shells are no longer needed and the document can be printed 

from any standard (colour) printer without any cropping. 

 The document is no longer in odd/even format, reducing the number of section breaks, 

particularly odd-page section breaks.  The margins have also changed to bring them into line 

with the Recommendation and Briefing document types with a view to updating them also to 
use Word's new functionality once the upgrade has been completed. 

 All the styles have been rebuilt from scratch with new names and there are only two types of 
heading: one numbered and one not. 

 While the common styles can still be accessed using the Ashurst Tab, the new Style Gallery 
contains the most common ones.  Unlike the Ashurst Tab, the Style Gallery uses "live preview" 

to show how the style will look before it is applied. 

 Because there are fewer styles, they all fit neatly in the style pane with "preview style" switched 

on, making it easier to decide which to use. 

 StandardAshurst is no longer removed and NormalBCONAshurst is now NormalAshurst.  All 

styles inherit their properties from the NormalAshurst base style. 

 The new template is "theme aware".  This means that its colour and font can be changed with a 

few clicks without the need for macros.  For example, an orange Verdana-based BCON can be 

quickly converted to Teal-Arial by our colleagues in the Jakarta office. 

 The new BCON is "region-aware".  This means that as soon as a user changes keyboard layout 

to an Asian language like Japanese or Arabic, the font changes automatically to Verdana's Asian 
or Arabic equivalent.  Both Chinese fonts (one for mainland China and one for Hong Kong) have 

been catered for. 

 The new table styles in Word 2010 have been adapted to offer a number of Ashurst-design 

table formats.  Creating well-formatted tables now only requires a few clicks and no need to use 

borders and shading dialogs. 
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 The number of macros has been significantly reduced.  The number of buttons on the Ashurst 

Tab (formerly the Ashurst toolbar) has also reduced. 

 Content controls have been used to direct you in completing all the required information needed 

for Photo Boxes, tombstones and the like. 

 The improved Building Blocks (formerly autotexts) lend themselves to tombstones, TOCs, Photo 

Boxes and the like making building a document more intuitive with fewer clicks. 

 It is now possible to automatically "look-up" photographs and details of an employee simply by 

entering part of a person's name in a content control and right-clicking.  That person's details 

as they are stored in Active Directory (the global address list) are imported along with their 
picture.  Photographs can be toggled between colour and black and white (as long as the 

photographs exist on the Marketing share) 

3. Terminology 

 Content control: A "frame" which contains specific content or data into which a user enters text, 
selects a date, adds a picture, selects a building block etc.  Content controls are like form fields 

but are directly accessible programmatically 

 Building block:  an autotext entry which is classified by category and type.  As with content 

controls, building blocks are accessible programmatically.  A combination of content controls 

and building blocks makes for less code and fewer dialog boxes.  Building blocks come with a 
preview making them easier to find.  Building blocks are stored inside templates and are 

therefore not available unless the template is installed.  If you want to save your own building 

blocks, unlike Word 2003, Word 2010 provides you automatically with a building block template 
stored in your profile.  If working in a document this will be the default.  If working in a 

template, the template will become the default.  The building block template has in its name 

"EN-US" which can be ignored; it does not affect language settings in any way. 

 Quick Part: another term for bulding block 

 Ribbon: the new "toolbar" in Word 2010 

 Tab: a collection of groups of buttons and menus on the Ribbon which covers an area of 
functionality in Word.  There is also an Ashurst tab containing all Ashurst template functionality 

 Group: a collection of buttons and other menu items found on a Tab 

 Gallery: a visual collection of commands.  Examples are the Styles Gallery, the Quick Parts 

gallery, the Colors gallery etc. 

 Theme: The beginning of the style hierarchy model which determines font, colour and shape 

effects.  Changing any of these through a Theme menu cascades the setting through all styles, 
table styles and anything else that has these properties.  Can also be set to change fonts when 

the input method is changed. 

 Table style:  a type of style for tables which holds settings for borders and shading, as well as 

cell alignment, padding etc.  Like styles they inherit their properties. 

 Banded rows/columns: a feature of tables whereby different shading, borders etc can be applied 

to alternating rows and/or columns 

 Document defaults: a new feature in Word documents which is effectively the base font size 

and paragraph format of all styles set to inherit.  It can be accessed through the Manage Styles 

dialog box 

 .docx and .doc: two very different file formats used by Word documents.  .Docx is the new 

format for Office 2010 and supports all the new features.  It is allegedly less prone to 
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corruption.  .Doc is the Word 2003 format and does not support any of the new features of 

Word 2010. 

 Compatibilty mode: when a .doc format document is opened in Word 2010, there is no access 

to the new features.  It is necessary to convert the document to the new .docx format if 

advanced functions are required. 

 Compatibilty pack: A plug-in for Word which allows it to read Word 2010 documents in the new 

file format.  It works well with simpler documents but results vary significantly with graphic and 
feature-rich documents.  If exchanging documents with someone on a different system, the 

Word 2010 user should convert the document to minimise the number of errors which might 

occur. 

 Backstage:  accessed through the File menu, the backstage contains behind-the-scenes tools 

such as printing options, recent files and File | New 

4. Approach 

It can be said that a BCON document is built using a collection of frequently used components such 

as CVs, photo boxes, tombstones etc.  The design of the template has taken this into consideration, 

and set these components as Quick Parts or Building Blocks.  These blocks have been categorised 
and can be found alongside Word's equivalents.  Most are also in galleries on the Ashurst tab in the 

Native Controls group. 

There is some programming behind the building blocks, but on the whole we are using Word's native 

functionality as far as possible.  To date any document based on an Ashurst Australia BCON 

template is not recognised as being an Ashurst document and therefore the Ashurst toolbar does not 
show.  This means the macros for inserting CVs, tombstones etc are not available.  With the new 

BCON template and Word 2010, the Building Blocks will still be available 

5. Starting a new document 

The BCON is accessed through the Back Stage in the same way as other document type.  It is listed 
under Business Development.  Select author, office and language and click create. 
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This is what you will see in the first instance.  The office list and the rubric/disclaimer have yet to be 

imported into the document.  This is by design. 

Paper size 

The default paper size for the BCON is A4.  However, the template has been constructed as far as 

possible with "US letter" in mind so that macros are not required to change page size and only one 
template is needed.  To change paper size select the whole document with Ctrl + A and use Word's 

own Page Layout | Size gallery.  Whilst the Quick Parts have been designed to work relative to the 

page, tables added to a document will likely be fixed-width as this is the Word default. 

Choosing a logo 

Because the same template is used by our colleagues at OSP and they use a different logo it is 

necessary to select the correct logo in the first instance.  Click on the text in the top right hand 

corner of the first page ("Choose a logo").  A drop down appears with a selection of logos.  Choose 
the most appropriate. 

Depending on your choice and the language selected when creating the BCON, the office list will be 
imported first.  You will then be prompted with the rubric/disclaimer dialog box as before.  The 

template still picks up the language chosen at creation, so if they are available, translations of the 

rubric and disclaimer will be imported. 

Office list 

The office (country) list on the front page runs over three lines by design. 
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Title and subtitle 

The next requirement is to give the document a title and subtitle.  There are two content controls 
above the graphic.  Simply click into the text, "Click here to enter text".  It will all be selected. Type 

in the title.  Repeat for the subtitle. 

You will notice that as soon as you click out of the content control, the title and subtitle repeated on 

the next page are automatically updated.  They are using a "StyleRef" field.  If you need to repeat 

the title or subtitle later in the document, copy/paste the field and apply an appropriate style.  If you 
change the title or subtitle of the document, all references to it will be updated as well. 

Choosing a date 

Next, click into the text which reads "Click here to enter a date".  A "date-picker" will appear.  Only 

the month and the year are used on the cover and the date-picker will format the text for you.  If 
your regional settings are set to a language other than English, the date-picker should format the 

date in the language set. 

There is also a date reference in the rubric/disclaimer section of the document.  This is the date of 

creation or the date set by choosing "Author/Date" on the Ashurst Tab.  The date on the coversheet 

and the date with the rubric are intentionally unconnected: one is a reference to the date of the 
pitch, the other is the Ashurst reference for when it was created and the copyright date.  

Tables of Contents 

If you know how many heading levels you want in the Table of Contents, go to the next page and 

click on "Select a table of contents".  A drop down will appear with the BCON ToCs categorised as 
such along with a preview.  Select the most appropriate.  If you selected a language other than 

English at creation and a translation is available, the ToC Contents and Appendix titles will be 

updated.  Note that if neither of the appendix styles (App1Ashurst or AppAshurst) are used in the 
document the appendix section of the ToC will be removed. 

To update the table of contents click on the tab at the top of the content control in which the ToC is 
embedded.  This will run the F9 macro, updating all the fields in the document.  If an appendix has 

been added since you last updated the ToC, the appendix section will be added back in by 

automatically re-inserting the ToC you selected in the first place.  Therefore, if you plan to update 
the Table of Contents manually, be aware that changes will be lost if you try to update the ToC.  If 

you intend to manually format the ToC, remove the content control and use Word's native dialog 

box or type the text in line-by-line. 

For reference, in the case of the upper section of the ToC, the "tramlines" are paragraph borders 

applied to the bottom of TOC 1 and TOC 2.  A border has also been applied to the Contents heading 
style TOCHeadingAshurst creating the first tramline at the top of the ToC.  Because only one level of 

heading is used for the appendix section, borders have been applied to the top and bottom of TOC 3. 

Rubrics and disclaimers 

The rubric and disclaimer section has been designed to move to the next page if the ToC "runs into 

it".  The table is anchored to the last paragraph on the second page of a new created BCON. 

Choosing a colour 

By now you have a new BCON with all its core components inserted.  The next step is to choose a 

colour.  On the Ashurst Tab click on the "Colors" button.  Only select a palette from the Custom 
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section.  The other colours are in-built Microsoft colours.  As with the Styles Gallery, you will see a 

live preview before you actually select the colour you want.  You can change the colour of the 

document at any time as many times as you like.  All "BCON coloured styles" 
will follow suit.  Note that the names given to the colours in the palette are 

generated by Word.  They are not the official Ashurst names which are used in 

the colour scheme names. 

If you ever need to change the "BCON colour" in the document it is "Text 2" in 

the palette.  This is also referred to as "Dark 2".  In the Fill and Border Colour 
Gallery it is the fourth item along.  (Colour schemes can be edited through the 

Colors gallery by right-clicking on a scheme and choosing Edit) 

 

Applying colours to elements in your BCON 

If you use shapes or smart art in your BCON you might want to change the colour used.  When 

selecting a fill or border colour, by default you are first offered the theme colours with tints and 
shades to choose from.  Whilst these are Ashurst approved using too many variations will make the 

publication look unprofessional.  Also, the tints and shades are calculated.  Sometimes they can 

appear garish.  If in doubt, it is best not to use it.  For best results use Text/Dark2 and tints/shades 
thereof.  If you decide to change the colour of your BCON, any elements with this colour applied will 

change automatically when a new colour theme is applied.  If you use colours from the Standard 

Colors section or from More Colors, they will not be "theme aware" and hence will stay as they are 
regardless of theme colour applied. 

This is an example of some text with Colour 2 applied.  If you change the colour of this 

document you will see the above text change colour as well. 

Choosing a font 

Changing the font of the document is just as easy.  Go to the Page Layout tab and in the Themes 

group select Fonts.  The customised items are Ashurst pre-sets: Arial for OSP, Times New Roman for 
offering circulars etc.  You can also select from the inbuilt combinations offered.  Note that the BCON 

template only uses the "Body" style type as Ashurst does not use another font for headings.  

Changing the font on the "Headings" style type will have no effect. 

If you use a Chinese, Japanese or Arabic keyboard, when you switch between input types the 

document will detect this and start to apply the appropriate font.  In mainland China this is StXiHei,  
in Hong Kong it is Jheng Hei, in Japan it is MS Mincho and in the UAE/Saudi Arabia it is Arial. 

Working with styles 

The way Word 2010 uses styles has changed and in parts is quite different to that of Word 2003.  In 

particular the way styles inherit their properties has been overhauled. 

In Word 2003 the Normal style was "hard-coded" to be Times New Roman 10 points.  It was 

possible to change it, but as soon as Normal.dot was deleted, Normal would revert to TNR.  The 
result was that organisations had to create their own Normal style, fixing the font and paragraph 

spacing as a starting point.  If anyone wanted to change the font of a document they had to change 

their specially made base Normal style.  This could cause problems if the styles were set to update 
automatically from the template – changes would be lost. 

In Word 2010 the Normal style has no properties set on it.  It has no font or paragraph spacing. 

Instead it inherits from the defaults applied to the template.  These can be accessed through the 

Style Manager from the Set Default tab.  We have applied the same technique to the BCON's 

NormalAshurst style. 
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If you look at the properties of NormalAshurst you will see that it is based on "(no style)" and that 

its spacing is set to 11 points.  This has actually been inherited from the document's defaults which 

are set to 11 points spacing with 11 points after.  If you change the defaults of the document, 
NormalAshurst changes too as do all styles based on it where the properties are shared. 

This becomes very useful when working with other documents.  If you were to copy text from this 
document into a standard document which has different line spacing, you would not need to "Paste 

Special".  Instead NormalAshurst would take on the defaults in the target document, and these 

would cascade through to any other styles you were pasting. 

Therefore if creating a base style allow it to inherit its font (Body), paragraph spacing, space before, 

space after and indents from the document's defaults.  Then try to keep the variations from the base 
to a minimum. 

This all becomes quite important when working with table styles. 

Table styles 

In Word 2003 by default a new table had few formatting rules and was quite simple requiring quite 

some time to apply and reapply borders and shading.  At Ashurst it was necessary to use a special 

style "TableAshurst" to align text in the cells correctly because NormalAshurst's paragraph spacing 
caused the text to sit awkwardly.   

Word 2010 has extended its paragraph and character styles to now include table styles.  As well as 
having paragraph spacing, every property of a table is also included.  This means that there are 

thousands of permutations.  It becomes more complicated because like standard styles, table styles 

also inherit. 

The styles available are only shown when you have clicked into a table.  A Table Tools Tab appears 

above the ribbon and contains two sub-tabs: Layout and Design.  The table styles are on the Design 
tab in a gallery of their own. 

L&D IT 
Business 

Services 

Business 

Development 
Catering 

Tom Fred Ginger Spice Girls 

Harry Sally Jo The Other Polly 

Jim Mike Eric Ernie Tom 

 

Note that table styles do not appear in the Styles pane or Styles gallery.  They do appear in the 

Classic Styles dropdown which you place on your QAT from the Customise Ribbon options in the 
backstage.  If you apply one of the table styles to ordinary text it will be converted to a table and 

formatted. 

In the BCON Ashurst's table styles are based on TableAshurst and then inherit to similar designs.  

Ashurst Table Style 1 – BCON colour is based on TableAshurst but then is the parent of the other 

table styles in the Table Style 1 group. 

Look at the style applied to the text in the above table.  You will see that the text in the header row 

in white bold is using the same style as the text in the rest of the table.  It is NormalAshurst.  You 
will also see that the paragraph spacing is set to single and that there is no space after.  This is not 

manual formatting.  This is because the font and paragraph spacing properties have not been set in 

Normal Ashurst but have been set in the table style.  Therefore NormalAshurst has had the blanks in 

its properties filled in by Ashurst Table Style 1 – BCON colour. 
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Interestingly, if you enter Ctrl + Q or Ctrl + Space which usually reset manual character and 

paragraph formatting, the document's default properties are reapplied to the style, but if you 

reapply NormalAshurst to the paragraph it returns to using the table style properties. 

Had we applied paragraph spacing to NormalAshurst and based it on another style like Normal, this 

is how the table would have appeared: 

The only workaround would be to 

create a new paragraph style solely 
for use in tables (as long as the 

tables were of a similar format) or 

manually format each cell's 
paragraph spacing.  Any difference in 

row height would require another 

custom paragraph style or more 
manual formatting. 

With Word 2010 the author does not need to think about extra paragraph styles.  If he or she is in 
NormalAshurst when it comes to creating a table, NormalAshurst will "adapt" as will any other styles 

constructed in the same way. 

This is the good news about table styles.  The bad news is that they can become quite awkward to 

configure. 

If you click into a table and go to the Table 

Design Tab you will see that there are 

options for rows and columns of tables.  If 
creating a new table style you should think 

about all the combinations and 

permutations and how they should be 
formatted.  If you intend for your table 

style never to be applied to a table with a 

total row then uncheck "Total Row" before 
starting to construct the style.  If you don't, the preview in the Modify Table Styles dialog will not 

show you the correct results. 

If applying borders in a table style to rows, apply borders to either the top or the bottom of the row 

and not both.  Cascade your new table style off a table style you know has no borders.  Apply 

borders to as few elements as possible because they too inherit and it can be quite tricky to work 
out where from if you base a number of table styles off a table style with borders. 

Do not use white borders to hide a border.  Use "No border" and if you know how to write macros 
set the Enabled property of Borders in the table style object to false.  Also, do not use the borders 

button in the Modify Table Style dialog.  Instead click on Format then Borders and access the 

traditional Borders dialog box you might have seen in Office 2003. 

If basing one table style on another, ensure that structurally the tables are as close to identical as 

possible.  Do not use banded rows in one, say, and banded columns in another or you will find 
pieces of border where you least expect them. 

Once you think you have completed creating the new style, check each of the options for the table 
(header row, total row etc) and review the preview in the design gallery.  What appears correct for 

one table type will appear quite different for another. 

As with standard styles, Word 2010 often does not see the change as relevant to the 

document/template you are working in so you will probably not be prompted to save on close.  In 

the immediate window in the Macros area (VBE) type: ActiveDocument.Saved = False <return> 
ActiveDocument.Save <return>.  This will force Word to save the document or template. 
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The style inheritance hierarchy 

This is a summary of what has been presented so far and can be considered best practice for 
working with Word 2010 documents: 

Fonts and Colours are parts of a theme and are aspects shared by every object in Word (character, 
paragraph, table, watermark etc).  The defaults are the Calibri font and the Office colour scheme 

which cannot be changed or removed. 

Paragraph spacing, indents and paragraph alignment are stored in the Document Defaults.  Between 

Themes and Document Defaults the core properties of all styles are set.  If a property is not 

configured in a style, the Theme and the Document Defaults will take precedence. 

Therefore the base style should not have any of these properties set and should be based on <no 

style>.  When setting the font, select "Body +" or "Headings +" 

Next comes the base table style.  It too should not have any of these properties set.  It should not 

have any borders or shading either. 

Properties set on styles override properties set on table styles.  Therefore, if a style is to be used 

also in a table and it does not share the same properties as the table style it will need to inherit its 
properties from another style or the document defaults. 

Finally comes manual formatting which overrides style and table style properties.  Therefore use it 
sparingly.  Any text with manual formatting applied has the potential to stop being theme and 

region aware. 

If you run into difficulties with the style hierarchy, go to the Styles group on the Home tab and 

select Change Styles.  Click on Style Sets and select the option to reset the styles back to the 

template.  If this does not work, in the Style Sets list select Word 2010 at the very bottom.  Then 
reset the styles back to those in the template.  The style hierarchy will be recreated but any manual 

formatting will still override the properties on a style. 

Remember that the more you use inheritance the fewer problems you will have copy/pasting 

because the amount of information being passed from document to document is reduced.  For 

example, because NormalAshurst is the base style of the BCON, copy/pasting into a standard 
document will render any NormalAshurst text with the document defaults.  In this case it is better to 

paste formatted!   (Technically you are not pasting formatted text at all.  You are pasting text with 

blank formatting properties).  If a document is theme aware, the pasted text will inherit the theme's 
fonts and colours reducing the need for reapplying styles etc.  If a client copy/pastes content from a 

BCON into their own document format which is based correctly on document defaults, the text from 

the BCON will auto-format itself to the client's design. 

Contact Box 

The contact box in the BCON is a table style.  Because there is no border on the bottom of the last 

row, the table needs to be set as having no Total Row but having a Header Row. 

Contacts    

Contact A    

Contact B    
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Inserting graphics 

Because NormalAshurst in the BCON has exactly 11 point spacing, if you paste in a graphic in-line 
you will only see the very bottom of the graphic.  Apply the style "PictureAshurst" to the graphic.  

The single spacing will allow the graphic the space it needs. 

Where possible use inline shapes/pictures rather than floating ones as floating shapes have a 

tendency to move when converting a Word 2010 document to Word 2003. 

Inserting CV data 

To import data and a photograph of an employee follow these steps: 

1. Insert a CV/Photo Box from Insert | Quick Parts or from Ashurst | Quick Parts 

2. Click into the uppermost content control which reads "Click here to enter name" 

3. Type the first part or all of the employee's name.  The more you type the quicker the search will 
be.  Note that the tool only returns the first sixteen of its search results due to limitations in the 

gallery. 

4. Right-click on the name and then choose CV data at the very bottom of the menu. 

5. You should be presented with a number of images with an employee's name and login id. 

 
6. Select the image you want. 

7. Note that you will need to have access to the Marketing Share \\gblondms06 to import 

photographs.  You will still be able to import employee details from Active Directory. 

8. Also note that the macro requires that the photographs follow the standard naming convention 

of starting with Surname + First name and then includes either "B&W" or "Col" to distinguish 

between black & white and colour pictures.  If a photograph cannot be found a "blank" 
photograph is shown.  Clicking on it will insert it into the document to remind you later that a 

photograph is required. 

  

file://gblondms06
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Mark Elsey 
Partner 

T: +44 (0)20 7859 1721 

M: +44 (0)7785 346 578 

Mark.Elsey@ashurst.com 

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor 

congue massa. Fusce posuere, magna sed pulvinar ultricies, purus  

  

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. Fusce 

posuere, magna sed pulvinar ultricies, purus lectus malesuada libero, sit amet commodo magna 

eros quis urna. 

Nunc viverra imperdiet enim. Fusce est. Vivamus a tellus. 

Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. Proin 

pharetra nonummy pede. Mauris et orci. 

 Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. 

Fusce posuere, magna sed pulvinar ultricies, purus lectus malesuada libero, sit amet commodo 

magna eros quis urna. 

 Nunc viverra imperdiet enim. Fusce est. Vivamus a tellus. 

 Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. 

Proin pharetra nonummy pede. Mauris et orci. 

 Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. 

Fusce posuere, magna sed pulvinar ultricies, purus lectus malesuada libero, sit amet commodo 

magna eros quis urna. 

 Nunc viverra imperdiet enim. Fusce est. Vivamus a tellus. 

Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. Proin 

pharetra nonummy pede. Mauris et orci. 

 

Note that the CV and Photo Boxes do not have a table style applied as they are functioning as 

placeholders rather than as tables of data. 
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Changing photos from colour to B&W 

Simply right-click on the photograph and half way down the menu is an option to change the CV 
picture.  This toggles the photograph type.  Right-clicking again will return the photograph to its 

initial state. 

Modifying tables containing content controls 

One of the properties of content controls is that they lock the surrounding area.  The content 
controls in the CV/photo box and tombstones are the same.  If you need to make changes to any of 

these do the following: 

1. Activate the Developer Tab through File | Options | Customize Ribbon 

2. Select a content control in the table you are trying to edit 

3. In the Controls group of the Developer Tab click on Design Mode.  Make changes to the table 

and then click on Design Mode again when you are finished. 

Fitting the picture into its cell 

If a picture does not fit quite right in the cell or has dropped slightly and is cropped at the bottom, 

go into the content controls' design mode and then from the Tables | Layout tab select Table 

Properties.  Go to the Cell tab and click Options.  Check the Fit Text option.  Exit design mode and 
the picture should sit perfectly in is cell. 

Inserting tombstones 

Tombstones are now accessed through Insert | Quick Parts or Ashurst | Quick Parts.  They contain 

two content controls, the upper formatted in Bold BCON colour (TombstoneBoldAshurst), the lower 

in black, TombstoneTextAshurst. 

Aligning and tombstones 

The new BCON design allows for text in tombstones to be centred vertically or aligned top.  If there 

are a lot of tombstones, setting each cell's vertical alignment can take time especially if there are 

merged cells in the table.  We have therefore included on the right click a toggle button to align the 
text at the top.  Clicking on the button again will centre the text.  Tombstones by default are centre 

aligned. 

Due to the introduction of table styles, sometimes when combining tables, cell widths will change 

marginally.  This is the case with the BCON tombstones when inserting one row after another.  

When a new row is inserted a macro runs to realign the cells 

Highlights 

There is a new Highlights box for the BCON.  This is accessed through Insert |Quick Parts or Ashurst 

| Quick Parts.  The title is a content control but the main body has not been given one because 

content controls do not lend themselves particularly well to text running over one line.  The title and 

the body each have their own styles HighlightTitleAshurst and HighlightTextAshurst respectively. 
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Quotations 

There are two new Quotation styles: QuoteAshurst which follows the BCON colour theme and 
Quote2Ashurst which is fixed in grey.  There is one source style for both – QuoteSourceAshurst. 

Office address list 

This is now accessed through Insert | Quick Parts or Ashurst | Quick Parts. 

Working with old BCONs 

Because the previous template and the new one are so different it is strongly advised that you do 
not attempt to attach the new template to a document based on the old template.  You will 

introduce another Normal style which is constructed differently to its Word 2010 counterpart, and it 

is highly likely that the new BCON's styles will inherit the old Normal's properties which in turn could 
cause formatting issues, incorrect paragraph spacing, loss of theme attributes, unworkable table 

styles and ultimately a corrupt document.  Unfortunately it is not possible to build a conversion 

macro as there is no direct relationship between, say, the numbering schemas in the old BCON and 
the simpler, single numbered list in the new one. 

If you need to copy text from an old BCON to the new format, first convert the document from .doc 
to .docx format.  If you do not, and even if you copy text over unformatted, because legacy style 

information is stored in a different format, it too can be carried over and get hidden in the document.  

The result is that the style gallery can become corrupt and new style attributes such as 
recommendation ignored.  Effectively the document will start to behave like an unconverted Word 

2003 document because it contains chunks of data in the old format. 

Once you have converted the document always copy/paste unformatted.  Do not attempt to keep 

the old numbering schemas as they have different tab-stops and the Table of Contents has not been 

set up to include them. 

Exchanging documents with Word 2003 users during the 

upgrade 

During the upgrade from Office 2003 to Office 2010 there will be those who have been upgraded 
and those who have not.  Therefore it is likely that documents will be exchanged between the two 

environments. 

In the first instance it is up to the Word 2010 user to save the document down to the former .doc 

format.  The new BCON will not open successfully if opened in .docx format on a PC with Office 2003.  

The graphics and logos will either shift or be deleted and the content controls in certain cases will be 
converted into badly formatted frames.  Once the BCON has been converted to a Word 2003 

document you are strongly advised not to make any edits in it until it is returned to you.  If you 

apply any styles to text, the text will inherit static properties from the style.  Effectively it will be as 
though it is manually formatted.  Further, there is a risk of causing errors in the Ashurst template 

system which is not fully backwards compatible to work with Ashurst Office 2003 documents. 

If possible determine between you who will have the document last prior to publication/sending.  

Ideally it should be the Word 2010 user and the document should be in .docx format as it ends its 

editing life cycle.  There will be less risk of corruption. 

If you are still using Word 2003 and receive a converted BCON from a 2010 user be aware that 

there will be direct formatting in the document where Word has filled in the blank properties so that 
visually the text is the same as if in Word 2010.  For example, in a table where NormalAshurst has 
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been used, you will see that the paragraph has 0 point spacing manually applied.  If you reset the 

paragraph style the formatting of the table will go awry. 

Do not attempt to reattach the BCON template to the document.  The compatibility packs will not be 

able to access a Word 2010 .dotx template file.  Also, try to keep manual formatting to a minimum 

as this might block the style hierarchy model when the document is returned to the Word 2010 user. 

Do not copy/paste formatted from other documents, especially those which used the former BCON 

template.  Just because both are in Word 2003 .doc format does not mean they are compatible with 
each other. 

If you are using Word 2010 and a new BCON in Word 2003 format is passed to you, do the following 
steps to reconvert it back to a usable Word 2010 document: 

1. Click on the File Tab to go to the backstage and click on Info.  Convert the document using 
Word's native convert function.  Do not use the Ashurst convert button. 

2. Go to the Developer tab and click on Document Template.  Select Automatically Update 
Document Styles, click OK, uncheck the option, click OK and close the dialog box. 

3. The font of the document will change to Microsoft's default Calibri.  Check the document to see if 
there are any parts not in Calibri.  They will most likely be in Verdana.  Highlight them. 

4. Go to the Page Layout Tab and in the Themes group click on the Font drop down.  Select Ashurst 
or OSP as appropriate.  The font should cascade through the styles.  It will not cascade to styles 

from Ashurst 2003 documents copy/pasted into the BCON and this is why you needed to 

highlight non-Calibri text.  You will need to reapply an appropriate style to the affected text to 
keep the document theme and region aware, as well as consistent. 

5. If the document doesn't change to Calibri this is most likely because the NormalAshurst style is 
not inheriting from the document defaults and the theme.  Right click on NormalAshurst in the 

Style Pane and select Modify. In the Based On drop down select <no style> and click OK.  If the 

base style was already <no style>, go to the Change Styles drop down in the Styles group, 
select Style Sets and apply the Word 2010 style set.  This should rectify the problem by 

removing properties found in the document defaults and theme on all styles based on <no 

style>.  Your document's text and tables should be theme and region aware again. 

6. During the conversion process the graphics and logo will have lost their themes so they need to 

be reapplied.  Click into the front page.  Then go to Insert | Coversheets and select the BCON 
coversheet.  The front and back pages will be replaced and the logos in the headers reset to be 

content controls.  You will then need to reselect your logo to update the rubric and disclaimer as 

well as the logos inside the document. 

7. Finally it is necessary to replace the Table of Contents.  Delete the existing one and position 

your cursor underneath the subtitle on the second page.Go to the References Tab | Table Of 
Contents or Ashurst | Table Of Contents and select a BCON TOC. 

"Publishing" your document 

Because there are compatibility problems between Word 2003 and Word 2010 you should always 

publish your BCON in PDF format.  To create a PDF go to Local Save As and in the drop down 
choose .PDF.  Word 2010 creates hyperlinks for the Table of Contents and be used to create links for 

cross-referencing if used.  Click on Options before saving for a list of settings you can apply. 

If a client insists on receiving a Word document, check before sending which version of Office they 

are using.  Match the format of the document you send.  As you can see there are inherent 

problems between versions.  If the client intends to reuse the content of the document in Word 2010 
ensure that it is all theme and region aware, and that the styles are inheriting properly.  A poorly 

constructed document will not look favourable.  If possible it is prudent to update and lock 

NormalAshurst's font and paragraph properties so that the Ashurst brand is maintained if the client 
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attempts to change fonts etc.  You can also block theme and quick style switching through the 

Styles Manager on the Restrict tab. 

Things to remember 

 Keep it simple 

 Use the Ashurst styles and table styles provided and try to avoid customisations such as 

applying the built in themes 

 Consider whether any customisation is actually needed.  Changes to the document's styles such 

as adding new numbering schemes should only be made if required by the end-user/reader 

 Avoid using direct formatting on text and tables.  Where possible create a new style or table 

style based on a similar style as direct formatting can be easily lost by reapplying a style or 
table style 

 Stay consistent. Do not mix colours, fonts and table styles (to name but three) in the same 
document 

 Keep in mind that documents based on the new BCON template are designed to be theme and 
region aware so that anyone at Ashurst can reuse them easily 

 If you choose to change something, think about whether it is a unique instance (e.g. applying 
bold to some significant text)  or whether it should apply throughout the document (e.g. 

changing the row height in tables).  Make the change at the most suitable place in the style 

hierarchy, as close to the base as possible.  In the table example you would modify the table 
style's paragraph spacing in the base AshurstTable style so that all table styles are updated.  

Otherwise you will end up with tables of varying row height which will look unprofessional. 

 Be careful when repurposing content from previous BCON versions and Word 2003 document 

types.  Text from websites should always be pasted as text as the underlying code is similar to 

that of Word 2010 documents and issues can arise 

 If things start to go wrong remember that the document stores a lot of its original settings so it 

is possible to revert styles and themes to their original 

 To avoid compatibilty issues, use inline graphics and not floating ones.  Word 2010 positions 

floating graphics and shapes differently to Word 2003 

 As with all complex document types, think content first and formatting later.  If you try to 

format as you enter the content, inconsistencies can creep into both.  Do one and then the 
other 

 Try to avoid converting .docx files to .doc files and back again.  If you need to collaborate with 
someone using a different environment think about whether it is actually necessary to share the 

same document.  It might be that the other party can draft in the new Word 2003 BCON 

template and then one or the other can copy/paste the content into the master document.  
Alternatively, it might be that they only want to review the content of the document in which 

case formatting errors caused by the conversion can be overlooked.  Consider sending a PDF if 

the review is of both content and format 

 Try to collaborate in the early stages of the document's life.  Converting and reconverting 

between file formats takes time, especially if the conversion causes formatting issues 

 



 

 

 

 

 

 


